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1 The list of terms 
1. The Guide – this document: Auto-Intellect Software Package, Operator’s Guide 

2. The system – the Auto-Intellect software system 

3. Traffic – the flow of vehicles 

4. LPR Viewer – the interface object designed for viewing the recognized LP numbers, the 

types and speeds of vehicles, as well as for searching the LPR database and creating 

reports for specific time periods. 

5. Traffic Monitor – the interface object designed for monitoring vehicle movement. 

 

2 Introduction 

2.1 The purpose and structure of the Guide 

The Guide is an informational reference designed for users of the Auto-Intellect system with 

Operator access rights.  

The Guide contains the following material: 

1. General description of the Auto-Intellect software system. 

2. How to use the Auto-Intellect software system 

3. Description of the user interface of the Auto-Intellect system 

2.2 The purpose of the Auto-Intellect system 

The Auto-Intellect software system is designed for automated traffic monitoring and control, and 

has the following functionality: 

1. License plate number recognition 

2. Centralized events registration and processing, generation of notifications and control 

commands according to flexible algorithms 

3. Searching matches between the recognized plate number and the numbers in the database 

connected to Auto-Intellect 

4. Creating the photo and video archive 

5. Determining the overall traffic parameters and the parameters of individual vehicles 

6. Software scalability 

2.3 Recommendations for using the Auto-Intellect system 

The Auto-Intellect software is installed as an extension to the Intellect software package. 

For proper operation of the Auto-Intellect system, please follow these recommendations: 

1. Follow the job description accurately 

2. Use the system for the intended purpose only 

3. Do not use the computer with Intellect installed, to run other software which is not part of 

the Intellect package. 

 

3 General description of the Auto-Intellect software package 

3.1 The structure of the Auto-Intellect software package 

Auto-Intellect includes the basic version of the Intellect software package with additional 

software modules that carry out particular functions: recognizing the vehicle parameters and 

registering the related events. 

Auto-Intellect includes the following software modules: 
1. Auto-Uragan 3.5.0.29; 

2. Arena; 

3. CARMEN-Auto; 
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4. Carmen-parking; 

5. ACCR; 

6. VIT; 

7. Radar; 

8. Traffic Detector; 

9. External Plates Database; 

10. Vehicle detector (included in information-gathering subsystem about traffic); 

11. Vehicle processor (included in information-gathering subsystem about traffic); 

12. Vehicle tracer. 

3.2 The Auto-Uragan 3.5.0.29 module functionality 

The Auto-Uragan 3.5.0.29 software module supports the following functionality: 

1. License plates identification; 

2. Saving the identified number to the plates detector database; 

3. Identification and logging the determined speed of the vehicle to the plates database (while 

connecting the Radar module); 

4. Identification and logging the determined class of a moving  vehicle to the plates database 
(while connecting the Traffic detector module); 

5. Check of identified license plates via connected search database; 
6. Possibility to work with multilane driveway; 
7. Identification of extended  list  of license plates types: all types of Russian license plates, all 

CIS countries  and Baltic States, countries of Europe, Latin America and The USA. Worked out 
the main types of single-line plates of different countries, for each both civil and specialized 
(diplomatic, transit, military etc.); 

8. Plates filtration according to their  characters’ sizes  
9. Possibility to change level of plates’ identification quality 
10. Saving the frames of the identified plates to bmp, jpeg and avi formats 
11. Calculation of the capture lanes in the area of identification restriction 

The Auto-Uragan 3.5.0.29 software module restricts working with different standard sizes of 
vehicle license plates. It also restricts working with template recognition with the absence of 
new licensing key.  
The Auto-Uragan 3.5.0.29 software module uses IPP 6.1 library.  
 

3.3 The Arena module functionality 

The Arena software module supports the following functionality: 

 
1. License plates identification. 

2. Saving the identified number to the plates detector database. 

3. Identification and logging the determined speed of the vehicle to the plates database. 

4. Identification and logging the determined class of a moving vehicle to the plates database. 

3.4 The CARMEN-Auto module functionality 

The CARMEN-Auto software module supports the following functionality: 
1. License plates identification. 

2. Saving the identified number to the plates detector database. 

3. Identification and logging the determined speed of the vehicle to the plates database (while 

connecting the Radar module). 



 6 

4. Identification and logging the determined class of a moving  vehicle to the plates database 
(while connecting the Traffic detector module). 

 

3.5 The CARMEN-parking module functionality 

The CARMEN-parking software module supports the following functionality: 
1. License plates identification. 

2. Saving the identified number to the plates detector database. 

3.6 The ACCR software module functionality 

The ACCR software module supports the following functionality: 
1. Recognizing the license plates of cargo containers. 

2. Saving the recognized number to the plates detector database. 

3.7 The VIT software module functionality 

The VIT software module supports the following functionality: 
1. Recognizing the license plates. 

2. Saving the recognized number to the plates detector database. 

3. Determining and logging the speed of the recognized vehicle to the plates database (if the Radar 

module is connected). 

4. Determining and logging the class of the recognized moving vehicle to the plates database (if 

the Transport detector is connected). 

5.  Check the recognized plates of vehicles via connected search database. 

6. Possibility to work with multilane driveway (recognizing of vehicle plates in one frame is not 

more than 10). 

7. Identification of extended list of license plates types: all types of Russian license plates, all CIS 

countries and Baltic States, countries of Europe, Latin America and The USA. Worked out the 

main types of single-line plates of different countries, for each both civil and specialized 

(diplomatic, transit, military etc.). 

8. Possibility to change the quality level of vehicle plates recognizing. 

9. Saving the frames of the recognized plates to bmp, jpeg and avi formats. 

10. Calculation of the capture lanes in the area of recognizing restriction. 

The VIT software module restricts working with different types of vehicle license plates in 
accordance to the Hasp licensing key. 
The VIT software module can work in one of the following modes: 
1. Slow — the module processes the video stream with the 6 fps speed. 

2. Fast – the module processes the video stream with the 25 fps speed. 

The working mode of the module also depends on Hasp licensing key. 

3.8 The Uragan software module functionality 

The Uragan software module supports the following functionality: 
1. Recognizing the numbers on the license plates and saving them to the database. 
2. Determining and saving the speed of the recognized vehicles to the database (if the Radar 

module is connected). 
3. Determining and saving the type of the recognized vehicles to the database (if the Radar module 

is connected). 
4. Searching the external database for the recognized numbers (if the External Plates Database 

module is connected). 
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3.9 The Radar software module functionality 

The Radar software module supports the following functionality: 

1. Registration of Radar (speed-trap) type devices. 

2. Detecting the vehicle speed using the connected Radar (speed-trap) device. 

3.10 The Traffic Detector software module functionality 

The Traffic Detector software module supports the following functionality: 

1. Determining the overall number of vehicles that passed in each lane 

2. Saving the date and time of vehicle registration 

3. Determining the types of vehicles 

4. Calculating the total number of vehicles of each type 

5. Determining the speed of the vehicles (using the video image processing algorithm) 

6. Determining the speed of the vehicles moving along a specified lane 

7. Calculating the average traffic speed 

8. Determining the average speed of passenger car vehicles 

9. Determining the average speed of truck vehicles 

10. Determining the distance between the vehicles 

11. Determining the road load 

12. Registering moving violations 

13. Detecting traffic jams 

3.11 The External Plates Database module functionality 

The External Plates Database module supports the following functionality: 

1. Matching the recognized numbers with the numbers in the external plates database. 

3.12 Auto terminal module functionality 

The Auto terminal program module is designed for video registration and identification of 

vehicles in auto terminals with fixed vehicle fleet.  

Note. Auto terminal with fixed vehicle fleet may be exemplified by Road Patrol Service shelf 

object. 

Module carries out the following functions: 
1 Identification of vehicle’s numbers that get into the field of view of recognizers, installed in the 

terminal’s entries (requires Uragan module connection). 

2 Identification of vehicles, registered in the auto terminal’s database, in the terminal’s entries. 

3 Vehicles’ numbers processing, registered in the auto terminal’s database, with automatic and 

manual status assignment.  

4 Research requests processing according to auto terminal’s database  
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4 Using the Auto-Intellect software system 

 

4.1 Starting and closing the system 

Please check the working condition of all hardware components – connections, cameras, etc – 

prior to starting the system. 

 
Figure 4.1-1 Starting the system 

 

The system can be started using one of the following methods (Figure 4.1-1): 

1. Automatically. The system starts automatically after the operating system boots up. 

2. Manually. To start the system manually, in the Start menu, select Programs, then 

Intellect, then Client Workstation, or use the corresponding shortcut on the Desktop. 

Access to the system can be protected by a password. In this case, enter your password to start 

the system. 

To shut down the system, do the following: 

1. Point the mouse to the upper right corner of the screen, the main control panel will open. 

2. Click the  icon on the panel. 

3. Select Shutdown in the menu that opens. 

The shut down process will start, the password will be required if set (Figure 4.1-2). 
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Figure 4.1-2 Shutting the system down with password confirmation 

 

Note. The system can be set up to forbid the shut down. Then, the Shutdown item is not present 

in the menu. 

4.2 Using the Traffic Monitor interface object 

4.2.1 Displaying the current traffic information in table form 

The table with current traffic parameters is shown in the Table sub-tab of the Current value tab 

(Figure 4.3.1-1 and 4.3.1-2). 

 

 
Figure 4.3.1-1 Displaying the current traffic parameters by lane in a table 
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Figure 4.3.1-2 Displaying the current traffic parameters by direction in a table 

 

The system can be set up to display the traffic parameters by lane or by traffic movement 

direction.  In case of the by-lane display, the columns correspond to traffic lanes, and rows 

correspond to traffic parameters. In case of the by-direction display, the columns correspond to 

traffic directions, and rows correspond to traffic parameters. 

Note. The Time of registration parameter for each lane corresponds to the time when the last 

vehicle passed. The Time of registration minus the Statistics update period is taken as the 

beginning of the period to base the statistics on, while the current moment is taken for the end of 

the statistics period. 

4.2.2 Displaying current traffic information in graphic form 

The charts with current traffic parameters are displayed in the Charts sub-tab of the Current 

value tab (Figure 4.3.2-1 and 4.3.2-2). 
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Figure 4.3.2-1 Displaying the charts of current traffic parameters by lane 

 

 
Figure 4.3.2-2  Displaying the charts of current traffic parameters by direction 

 

The system can be set up to display the traffic parameters by lane or by traffic movement 

direction.  

The Charts tab consists of several sections corresponding to the lanes or the traffic movement 

directions. Each section consists of several subsections displaying some particular sets of traffic 

parameters in graphic form. 
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4.2.3 Creating a request for traffic statistics 

To create a request for traffic statistics, use the Statistics tab (Figure 4.3.3-1). 

 

 
Figure 4.3.3-1 Creating a request for traffic statistics 

 

To create a request for traffic statistics, do the following: 

1. Select the preferred type of statistics presentation by clicking the Table or the Charts 

tab. 

2. Select the sampling period – Day, Week, Month, or Specific time period (specify the 

period manually). 

3. If Specific time period is chosen, enter the beginning and the end date/time of the 

statistics period in the Beginning and the End fields. 

4. Click the Refresh button to create or update the statistics. 

4.2.4 Displaying traffic statistics in table form 

The traffic statistics in table form are displayed in the Table sub-tab of the Statistics tab (Figure  

4.3.4-1). 
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Figure 4.3.4-1 Displaying traffic statistics in table form 

 

The traffic statistics are displayed in the following tree structure:  Recognizer name  

Movement direction  Lane  Vehicle type. The statistics data for each level of the tree is 

shown. 

Note. To refresh the displayed statistics, click the Refresh button. 

4.2.5 Displaying traffic statistics in graphic form 

The traffic statistics in graphic form are displayed in the Charts sub-tab of the Statistics tab 

(Figure  4.3.5-1). 
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Figure 4.3.5-1 Displaying traffic statistics in graphic form 

 

Note. To refresh the displayed statistics, click the Refresh button. 

4.2.6 Saving traffic statistics to a file 

The Statistics tab allows saving the traffic statistics into a file (Figure   4.3.6-1). 
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Figure 4.3.6-1 Saving traffic statistics into a file 

 

To export the traffic statistics into a file, do the following: 

1. Create and display the request for traffic statistics (see the Creating the traffic statistics 

request section) 

2. Click the Save as button. 

3. Enter the pathname in the window that opens and click Save. 

4. The traffic statistics will be saved in the specified location in a CSV file. 

4.3 The LPR channel interface object 

4.3.1 Introduction 

The LPR channel interface object includes the following components: 

1. «On-line monitor» – is designed for displaying the data about identified plates and  for 

handling alarms; 

2. «Events monitor» –displays video frame with a vehicle, which plate is being recognized 

at the moment and also identified number and speed. 

Note. Events monitor component is optional and isn’t displayed with corresponding system 

settings (see the document «Auto-Intellect software complex: Administrator guide»). 

4.3.2 Viewing the data about passing vehicle  

Viewing the data about passing vehicle is performed in the window Events monitor (Fig. 4.3—

1). 
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Fig. 4.3—1 Viewing the data about passing vehicle 

In the Events monitor window the following data is displayed: 
LPR channel (the name of the corresponding object LPR channel ») (Fig. 4.3—1, 1); 

1. Vehicle’s  video frame with a sing, containing the following data (Fig. 4.3—1, 2): 

a. Date and time of receiving  data about the vehicle; 

b. Vehicle’s speed; 

c. Vehicle’s  direction; 

d. Speed, allowed on the controlled area of the road; 

e. Vehicle’s detector id number; 

f. Control site. 

2. Vehicle’s identified number and speed (Fig. 4.3—1, 3). 

Note1. In case, when Uragan or CARMEN-Auto  module is used for identification, allowed 

speed, vehicle’s speed and speed detector’s number are displayed only if the Radar module is 

connected (see the document  ««Auto-Intellect software complex: Administrator guide »). 

Note 2.In case when alarm is registered for a vehicle (overspeeding, and /or identification of a 

plate in the external plates database), a field with a video frame is underlined red (Fig. 4.3—1, 

2). 

 

4.3.3 Viewing the data about the last identified vehicle 

Viewing the data about the last identified vehicle is performed in the group «Last event» of «On-

line monitor» window (Fig. 4.3—2). 
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Fig. 4.3—2 Data about the last identified vehicle 

Note. If there is selected an event in the identified vehicles protocol or in the alarms protocol, the 

data about this event will be displayed in the group Last event (see sections «Viewing the 

protocol of the identified vehicles», «Viewing the alarms protocol»).  

Viewing the data about the last identified vehicle is performed in the following way: 
1. In field 1 there is displayed a vehicle’s video frame with a sign (Fig. 4.3—3, 1). 
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Fig. 4.3—3 Viewing the data about the last identified vehicle 

2. Identified vehicle’s plate is displayed in Field 2 (Fig. 4.3—3, 2). 

Note. In case when a plate hasn’t been recognized, Unidentified message will be displayed in the 

field. 
3. In the detector string the name of plate’s detector is displayed (the name of the corresponding 

object «LPR channel») (Fig. 4.3—3, 3). 

4. In the country string there is displayed a country in accordance with the  identified number(Fig. 

4.3—3,4). 

Note. The country is displayed only in case when the Uragan or CARMEN-Auto modules are used 

for recognition.  

 

5. Camera’s installation address is displayed in the string Address (Fig. 4.3—3, 5). 

6. Camera’s identifier number is displayed in the string ID (№) (Fig. 4.3—3, 6). 

7. Certificate’s number is displayed in the string Certificate (Fig. 4.3—3, 7). 

8. The date, until which verification is valid is displayed in the string Verification valid (Fig. 4.3—3, 

8). 

9. In the string Receiving time there is displayed the date and receiving time of vehicle’s 

information (Fig. 4.3—3, 9). 
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10. In the string Speed there is displayed vehicle’s speed (Fig. 4.3—3, 10). 

Note1. In case, if Uragan or CARMEN-Auto modules are used for identification and Radar 

module is not connected, zero speed value is displayed. 

Note 2. Dependent on LPR channel settings the speed is displayed in km/h or m/h (see the 

document «Auto-Intellect program complex: Administrator guide). 
11. In the string Permitted speed there is displayed maximum permitted speed  on this road’s area 

(Fig. 4.3—3, 11). 

12. In the string Validity there is displayed validity of identified plate in percent (Fig. 4.3—3, 12). 

13. In the string Direction there is displayed vehicle’s direction («Towards the camera » or «Off the 

camera») (Fig. 4.3—3, 13). 

Viewing the data about the last identified vehicle is over. 

Note1. In case if there is registered an alarm for a vehicle, the reason of alarm is also displayed 

in the group Last event.  

Note2. In the same way one can view the data about any event, selected in the identified vehicles 

protocol or in the alarm protocol (see sections Viewing the protocol of identified vehicles, 

Viewing the alarms protocol). 

4.3.4 Viewing the protocol of identified vehicles 

Viewing the protocol of identified vehicles is performed in On-line monitor window (Fig. 4.3—

4). 

 
Fig. 4.3—4Identified vehicle’s protocol 

 

The protocol of identified vehicles is a table which contains information about identified vehicles 

(Fig. 4.3—4, 2). Select the tab Events, displaying the protocol of identified vehicles, to access to 

the protocol (Fig. 4.3—4, 1). 
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Fig. 4.3—5 Viewing the identified vehicles protocol 

For every vehicle (event) there are displayed the following data: 
1. video frame of the vehicle(Fig. 4.3—5, 1); 

2. Identified vehicle’s number (Fig. 4.3—5, 2); 

3. Vehicle’s speed; 

4. LPR channel (Fig. 4.3—5, 3); 

5. Time of receiving I information about the vehicle (Fig. 4.3—5, 4). 

Note. In case, when Uragan or CARMEN-Auto module is used for identification, vehicle’s speed 

is displayed only if the Radar module is connected» (see the document «Auto-Intellect program 

complex: Administrator guide). 

For alarms there is displayed information about reasons of alarms (see section «Alarms 

operation»). Unprocessed by the operator alarms are underlined red, processed-underlined 

yellow (see section «Alarm’s processing»). 

Note. Processed events may not be displayed (see section «Hiding the processed events in the 

protocols»). 

To view the detailed information about the event it is necessary to perform the following actions: 
1. Click with a left mouse button upon the required event. 

2. The data about the event will be displayed in the group Last event in result. Operative update of 

the identified vehicles protocol will be suspended in the process. 

3. Viewing the data about the event according to section «Viewing the data about the last 

identified vehicle». 

To restore the active update of identified vehicles protocol click the Trace button in the upper 

area of the On-line monitor window (Fig. 4.3—6). 
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Fig. 4.3—6 Restoring the active update of identified vehicles protocol 

Viewing the detailed data about the event is over. 

4.3.5 Alarms operation 

Alarms operation is done in the On-line monitor window. 

Alarm is triggered by one of the following ways: 
1. automatically – in coarse of overspeeding or vehicle’s plate identification in the external 

database; 

2. manually. 

4.3.5.1 Manual triggering the alarm 

Manual triggering the alarm is done in the following way: 
1. Select the required event in the identified vehicles protocol, clicking it with a left button of the 

mouse (Fig. 4.3—7, 1). 
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Fig. 4.3—7 Manual triggering the event 

2. Click the Alarm button (Fig. 4.3—7, 2). 

3. In result of this operation the event will be underlined red and added to the alarms protocol 

(Fig. 4.3—8, 1).For an alarm, triggered by operator, there is displayed the reason of alarm 

«Marked by operator» and the time of triggering the event (Fig. 4.3—8, 2). 

 
Fig. 4.3—8 Alarm reason-Marked by operator 

Note. Information about alarms protocol is given in the section «Viewing the alarms protocol». 

Manual triggering the alarm is completed. 

4.3.5.2 Viewing the alarms protocol 

Alarms protocol is a table which contains information about vehicles for which alarm has been 

triggered (Fig. 4.3—9, 2). It necessary to activate a tab, that is located in the upper area of the 

On-line monitor window to access to access to the protocol (Fig. 4.3—9, 1).  
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Note. There is displayed data about the last alarm on the tab. 

 
Fig. 4.3—9 Viewing the alarms protocol 

Unprocessed by operator alarms are underlined red, processed-underlined yellow (see section 

«Alarm processing»). 

Note. Processed events may not be displayed (see section «Hiding the processed events in the 

protocols»). 

Viewing the alarm protocol is done in a similar way with identified vehicles protocol (see section 

Viewing the identified vehicles protocol). The difference is that for an alarm there is displayed 

information about the reason of alarm: 
1. «Marked by operator» - in case, when the alarm is triggered by operator (the time of triggering 

is also stated); 

2. «Is found in:  <external database name >» - in case, when the identified plate is found in the 

external database; 

3. «Overspeeding» - in case, when the vehicle’s overspeeding is registered. 

Detailed information about an alarm with stating the reason of alarm one can see in the group Lat 

event (see section Viewing the data about the last identified vehicle). Viewing the detailed 

information about an alarm is similar with viewing the data about the event, registered in the 

identified vehicles protocol (see section Viewing the identified vehicles protocol). 

In case when the identified vehicle’s plate is found in the External Plates Database, the 

information about the vehicle, stored at this base, will be displayed. (Fig. 4.3—10). 
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Fig. 4.3—10Information about the vehicle, found in the External Plates database 

4.3.5.3 Alarm processing 

Alarm processing is done in the following way: 
1. Select an alarm in the identified vehicles protocol or in the alarms protocol, clicking it by a left 

mouse button (Fig. 4.3—11, 1). 

 
Fig. 4.3—11 Alarm processing 

2. Click Accept (Fig. 4.3—11, 2). 

3. The event will be underlined yellow in result (Fig. 4.3—11, 3). 

Alarm processing is completed. 
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4.3.5.4 Hiding the processed events in the protocol 

There is possibility to hide processed events in the identified vehicles protocol and alarms 

protocol. To realize this possibility it is necessary to click the button Processed Hide (Fig. 4.3—

12). 

 
Fig. 4.3—12 Hiding the processed events 

4.3.6 Adding the comments to the events 

There is possibility to add commentary to the events. This possibility is realized in the ON-line 

monitor window. 

Note! There is possibility to comment accepted events (are underlined yellow) is not provided. 

 To add a commentary to the event one has to carry out the following events: 
1. To select an event in the identified vehicles protocol or events protocol, click it with a left mouse 

button (Fig. 4.3—13, 1). Operative update of the protocol, displayed on the screen, will be 

suspended in result. 
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Fig. 4.3—13 Adding the comments to the event 

2. Click Comment (Fig. 4.3—13, 2). 

3. Comments window will open in result (Fig. 4.3—13). 

 
Fig. 4.3—14 Comments dialog window 

4. Enter the comment in the field after the stated date (Fig. 4.3—14, 1) 

5. Click Add button to apply the comment to the event (Fig. 4.3—14, 2). 
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6. Repeat steps 2-5 for all the required comments. 

7. To resume operative update of the protocol, displayed on the screen, click Trace button (Fig. 

4.3—13, 3). 

Adding the comments to the event is completed. 

To view the comments to the event the required value should be selected in the identified 

vehicles protocol or in the alarms protocol. Comments will be displayed in one field (Fig. 4.3—

13, 4). 

4.3.7 Printing and exporting the data about the vehicle 

Printing and exporting the data about the vehicle is done in the following way: 
1. Select an event in the identified vehicles protocol or events protocol, clicking upon it with a left 

mouse button (Fig. 4.3—15, 1). Operative update of the protocol, displayed on the screen, will 

be suspended in result. 

 

 
Fig. 4.3—15 Printing and exporting the data about the vehicle 

2. To build a report with vehicle characteristics click the Print button (Fig. 4.3—15, 2). 

3. Preview report program will be run in result. Vehicle characteristics report will be displayed in 

this program’s window (Fig. 4.3—16). 
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Fig. 4.3—16 Vehicle characteristics preview report 

4. Carry out the necessary operations (Table 4.3-1) with a report, then quit the program for 

viewing the reports, having executed the point of the main menu File ->Exit viewer  or clicked 

the button« ». 

Table 4.3-1 List of operations with a report 

Operation Call for operation 

Start in the main 

menu 

Start in the 

contextual window 

Button on the toolbar 

Open the report, saved in.rsd or .xml File->Open - 
 

Save the report in  .rsd or .xml File ->Save - 
 

Export the report to one of the most common 

formats 

File ->Export - 
 

Print the report File ->Print - 
 

Activate the tool «Arm» View-> Scrolling Scrolling 
 

Zoom in the displaying of report’s pages View ->Zoom in Zoom in 
 

Zoom out the displaying of report’s pages  View ->Zoom out Zoom out 
 

Enable dynamic scaling of report’s pages View ->Dynamic 

scaling 

Dynamic scaling 
 

Zoom in the selected  region scaling View ->Region 

scaling 

Region scaling 
 

Scale in  page size View ->In page In page size 
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Operation Call for operation 

Start in the main 

menu 

Start in the 

contextual window 

Button on the toolbar 

size 

Scale in page’s width size View ->In page’s 

width size 

In page’s width size 
 

Display pages in real size View -> Real size Real size 
 

Enter or select from the list the required scale of 

displaying the report’s pages 

View ->Set the 

scaling 

Set the scaling 
 

Enable the mode of nonstop paginal report’s 

displaying  

- - 
 

Enable the mode of  by one page report’s displaying  - - 
 

Go to the first report’s page Navigate->The 

first page 

The first page 
 

Go to the previous report’s page Navigate -

>Previous page 

Previous page 
 

Go to the next report’s page  Navigate ->The 

next page 

The next page 
 

Go to the last report’s page Navigate ->The 

last page 

The last page 
 

Go to the required report’s page (call for a dialog 

window « Go to page ») 

Navigate -> Go to 

page 

- - 

Display the previous report’s view Navigate ->Back Back 
 

Display the next report’s view Navigate -

>Forward 

Forward 
 

Find the required characters string in the report  Document->Find Find 
 

Update the report Document -> 

Update 

Update 
 

Edit the report (open the editing program) Document ->Edit 

the report 

Edit the report 
 

Display report’s content - - 
 

Display information about the program to view the 

report 

Help -> About 

program 

- - 

Close the preview report program  File ->Close - - 

Note 1. Operations with report files (opening, saving, exporting, and printing) are performed 

with standard dialog OS Windows. 

Note2. To go to the required page one should enter page’s number in the field «Page №» of «Go 

to page» dialog window and then click OK. 
5. To resume operative update of displayed protocol click the Track button. (Fig. 4.3—15, 3). 

Printing and exporting the data about the vehicle is completed. 

4.3.8 Viewing the video archive by event 

There is possibility to command from the component On-line monitor in order to reproduce the 

video archive by event in the interface window the Monitor. 

Note. The preliminary set Monitor object should be selected as a monitor for controlling  on the 

LPR channel settings panel. (see the document «Auto-Intellect software complex: Administrator 

Guide »). 

To view the video archive by event do the following: 
1. Select the event in the identification vehicles protocol or alarms protocol, clicking upon it with a 

left mouse button (Fig. 4.3—17). Operative update of the protocol, displayed on the screen, will 

be suspended in result. 
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Fig. 4.3—17 Access to video archive by event 

1. Click Video archive (Fig. 4.3—17, 2). 

2. In case, when currently the monitor with a video surveillance corresponding to the plates 

identification camera is displayed on the screen, this video surveillance window will enable the 

mode of displaying the archive recording by the event (Fig. 4.3—18). Video archive navigation is 

described in the document «Program complex «Intellect base»: Operator guide ». To close the 

video archive displaying mode it is necessary to click with a left button upon the sign « » in 

the right bottom corner of the video surveillance window. 
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Fig. 4.3—18Viewing the video archive by event 

3.  To resume operative update of displayed protocol click the Track button (Fig. 4.3—17, 3). 

Viewing the video archive by event is completed. 

4.3.9 Using the filters in the protocols 

There is possibility to select events to be displayed in the identified vehicles protocol and alarms 

protocol.  

Note! Both displayed and hidden in the protocol events are saved in the recognizer’s database 

of the Auto-Intellect Software. 
Events may be selected, using the following events: 

1. speed; 

2. overspeeding; 

3. plate; 

4. validity; 

5. region;  

6. direction; 

7. alarm type; 

8. identifiers. 

Selection of filters, used in the protocols, is done in the following way: 
1. Click Filter button in the ON-line monitor window (Fig. 4.3—19, 1). 
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Fig. 4.3—19 Using the filters in the protocol 

2. Filters dialog window will be displayed in result (Fig. 4.3—20). 



 33 

 
Fig. 4.3—20 Filters dialog window 

3. From the list Speed (Fig. 4.3—20, 1) select the required filter according to vehicle’s speed, then 

enter the threshold value of the speed in the field(s) in km/h.  

The following speed filters are available: 

a. «Is not filtered» — the event is displayed in protocols with any vehicle’s speed. 

b. «More» — the event is displayed in protocols in case when vehicle’s speed is over 

threshold value (Fig. 4.3—21). 

 
Fig. 4.3—21 «More» speed filter 

  
c.  «Less» — the event is displayed in protocols in case when vehicle’s speed doesn’t 

exceed the threshold value (Fig. 4.3—22). 
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Fig. 4.3—22 «Less» speed filter 

  
d.  «Interval» — the event is displayed in protocols in case when vehicle’s speed 

corresponds to the entered range of threshold value (Fig. 4.3—23). 

 
Fig. 4.3—23 «Interval» speed filter 

4. From the list Speeding (Fig. 4.3—20, 2) select the required vehicle’s overspeeding filter and then 

enter threshold value of overspeeding in km/h.  

The following overspeeding filters are available: 

a. «Is not filtered» — the event is displayed in protocols with any vehicle’s overspeeding. 

b. «More» — the event is displayed in protocols in case when vehicle’s overspeeding is 

over the threshold value (Fig. 4.3—24). 

 
Fig. 4.3—24 «More»overspeeding filter 

Note. The threshold value is calculated as a difference between the fixed vehicle’s speed and the 

speed, permitted in the controlled area of the road. 
5. From the list Number (Fig. 4.3—20, 3) select the required vehicle’s plate filter and then in the 

field enter the number or its part which identification leads to event’s displaying in protocols.  

The following plate filters are available: 

a. «Is not filtered» — the event is displayed in protocols with any vehicle’s plate. 

b. «Exact matching» — vehicle’s event is displayed in protocols in case, when vehicle’s 

plate exactly matches the entered value (Fig. 4.3—25). 

 
Fig. 4.3—25 « Exact matching » plate filter 

c.  «Contains» — vehicle’s event is displayed in protocols in case, when vehicle’s plate 

contains the entered value (Fig. 4.3—26). 

 
Fig. 4.3—26« Contains » plate filter 

  

Note. The expression, given for filters «Exact matching» and «Contains», may include usual 

characters and characters «*», stating for an unidentified plate’s character. If the expression   

contains one or several characters «*», there are displayed only plates, containing unidentified 

characters in the set combination, in the protocols.  
6. From the Validity list (Fig. 4.3—20, 4) select the required filter on percent of vehicle plates 

recognizing and then enter the threshold value of recognizing validity in the opened field (s). 
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The following validity filters are available: 

a. «No filtering» - events are displayed for those vehicles which plates are recognized with 

any validity. 

b. «More» - events are displayed in the protocol if the recognizing validity is higher than 

the specified value. 

 
Fig. 4.3—27 «More» validity filter 

c. «Interval» - vehicle event is displayed in the protocol if the recognizing validity of vehicle 

plate belongs to the specified range of threshold values (Fig. 4.3—28).  

 
Fig. 4.3—28 «Interval» validity filter 

7. From the Region list (Fig. 4.3—20, 4) select the required region’s filter, where the vehicle has 

been registered, and then enter region’s number in the appeared window (Fig. 4.3—20, 4).  

The following region’s filters are available: 

a. «Is not filtered» — the events are displayed in protocols of the vehicles, registered in 

any region. 

b. «Equal» — the events are displayed in protocols of the vehicles, registered in the given 

region (Fig. 4.3—29). 

 
Fig. 4.3—29 « Equal » region filter 

  
8. From the Direction list (Fig. 4.3—20, 5) select vehicle’s direction with which the event should be 

displayed in protocols.  

The following direction filters are available: 

a. «Is not filtered» — the vehicle’s events are displayed in protocols with any direction in 

respect of the plates identification camera. 

b. «From camera» — the vehicle’s event is displayed in case, when the vehicle was 

moving from the camera (Fig. 4.3—30). 

 
Fig. 4.3—30« From camera» direction filter 

  
c.  «Towards the camera» — the vehicle’s events are displayed in protocols in case, when 

the vehicle was moving towards the camera (Fig. 4.3—31). 

 
Fig. 4.3—31« Towards the camera» direction filter 
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9. From the Alarms list select the alarm type (Fig. 4.3—20, 6). Only alarms of the selected type will 

be displayed in protocols.  

The next alarm type filters are available: 

a. «Is not filtered» — the vehicle’s events are displayed in protocols with any alarm type 

or its absence. 

b. «Overspeeding» — the vehicle’s events for which overspeeding has been registered are 

displayed in protocols (Fig. 4.3—32). 

 
Fig. 4.3—32« Overspeeding» alarm type filter 

  
c.  «LP found in Database» — the vehicle’s events which plates have been found in the 

external plates database are displayed in protocols (Fig. 4.3—33). 

 
Fig. 4.3—33« LP found in database» alarm type filter 

  
d.  «Alarm set by operator» — the vehicle’s events, initialized manually,  are displayed in 

protocols (Fig. 4.3—34). 

 
Fig. 4.3—34« Alarm set by operator» alarm type filter 

10. In the group«Plates identifiers» (Fig. 4.3—20, 7) set the checkboxes for those LP recognition 

Servers, which data have to be displayed in protocols. 

11. Click OK to save filters settings and close the Filters dialog window (Fig. 4.3—20, 8). 

Note. To reset all the settings it is convenient to use Reset button (Fig. 4.3—20, 9). 

Selecting the filters, used in protocols is over. 

There is possibility to disable filters without changing the settings in Filters dialog window. 

Click the button Show all for it (Fig. 4.3—19, 2). All the registered events will be displayed in 

protocols in result.   To resume the usage of filters, this button should be repeatedly pressed. 

4.3.10 Viewing the LPR channel errors 

With LPR channel errors the Server status button in the right upper corner of On-line monitor 

window is green (Fig. 4.3—35) (Fig. 4.3—36). If errors are registered, the button is red (Fig. 

4.3—37). 
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Fig. 4.3—35 Viewing the LPR channel errors 

 
Fig. 4.3—36The absence of LPR channel errors 

 
Fig. 4.3—37 The LPR channel errors 

To view the LPR channel errors, do the following: 

1. Click the button« ». 

2. Errors dialog window will be displayed in result (Fig. 4.3—38 Errors dialog windowFig. 4.3—38) 
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Fig. 4.3—38 Errors dialog window 

3. Data about occurred errors are displayed in Field 1(Fig. 4.3—38, 1). 

4. A list of all possible error sources is displayed in Field 2: LPR channels and/or external databases. 

Current error sources are marked by sign « », idle sources are marked by sign « » (see Fig. 

4.3—38, 2). 

5. To delete data about errors and close Errors dialog window click Clear button (see Fig. 4.3—38, 

3). 

6. To close Errors dialog window without deleting data about mistakes, click « » button.  

7. The button Server status will become green in result (Fig. 4.3—35). 

 

Viewing the LPR channel errors is completed. 

4.3.11 Creating the additional components of On-line monitor 

 

There is possibility to create additional interface components «On-line monitor». Make a left 

double click upon the component Events monitor to create an additional component (Fig. 4.3—

39). In result of this operation there will be displayed an additional On-line monitor component 

in the center of the screen. 
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Fig. 4.3—39Creating the components of on-line monitor 

Note 1. Events monitor component may not be displayed due to corresponding system settings 

(see the document «Auto-Intellect program complex: Administrator guide»). 

4.3.12 Searching the events in the recognizer’s databases 

Searching the events in the recognizer’s databases of the Auto-Intellect program complex is 

performed in the dialog window «Events search in the recognizer’s databases ». To call for this 

window click the Search button in the interface object On-line monitor. 

 
Fig. 4.3—40 Searching the events in the recognizer’s databases 

Full functionality, provided to operator in the window Searching the events in the recognizer’s 

databases, is the following: 
1. Searching the events, stored at both local and remote recognizer’s databases of the Auto-

Intellect program complex. 

2. Printing the reports concerning the search results. 

3. Creating an own plates database (Base «Active tracer »). 
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4.3.12.1 Setting up the events search 

Events search is set up in the following way: 
1. Select the database, where events should be searched. 

2. Set up the displaying of events search. 

3. Set up the video archive.  

4.3.12.1.1 Selecting recognizer databases for events search   

To select recognizer databases for events search, select servers where required LPR databases 

are. To carry this out  select the point  «Servers» -> «<Name of the required database>» of the 

main menu in the «Event search in the Recognizers DBs » window (Fig. 4.3—41). As a result 

the server will be marked with « » icon. 

 
Fig. 4.3—41 Selecting recognizer database for event search 

 

Note. To select all system servers select the point «Servers» -> «Select all». 

There will be search by selected servers.  
 

4.3.12.1.2 Event search results setup 

Event search results are presented in the table. There is a possibility to choose which table’s 

columns should be displayed and which shouldn’t, to add new columns and also edit their 

displayed names. 

To set up the displaying of search results do the following: 
1. Select «Settings» in the main menu of the Events search in recognizers databases (Fig. 4.3—42). 

 
 

Fig. 4.3—42 Access to search results setup 

As a result Settings dialog box is displayed. (Fig. 4.3—43). Set up of the event search results 

displaying is carried out in «Configure fields» tab. 
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Fig. 4.3—43 Settings window 

2. In the central field of the window (Fig. 4.3—43, 1) set the checkboxes for the columns that 

should be displayed in event search results table (Table 4.3-2). 

Note. For displaying all the available columns in the search results table set the checkbox 

«Select/deselect» (Fig. 4.3—43, 2). If this checkbox isn’t set, search results table is not 

displayed. 
Table 4.3-2 Event search results table’s columns 

Column name (on default) Column’s content 

Frame Video frame with a vehicle 

Vehicle’s speed Vehicle’s speed 

Number Identified plate’s number 

Region number Region of identified number 

Country Country of the identified number 

Detector name Object name «LPR channelС», corresponding to Vehicle’s detector number  

Date Data of vehicle’s identification 

Detector address Number’s detector address 

Valid speed, km\h Speed in km\h , that is valid on the road’s area/ controlled by number’s detector 

Overspeed, km\h Vehicle’s overspeeding in km\h 

Direction A check, that the vehicle was moving  towards the camera, detecting numbers 

Authenticity, % Plates identification authenticity is given in percent  

Alarm time Time of alarm registration according to the identified number  

Alarm detection time Time of alarm detection  by the PC operator of the Auto-Intellect 

Delay of alarm acceptance, sec Time between registering the alarm and its acceptance by operator 

Commentary Commentary , added by the operator to the event with a vehicle 

Alarm type Alarm type(overspeeding or vehicle’s identification in the external plates databases) 

Alarm processed A check, that the alarm has been accepted by the operator 

External database A check, that the alarm has been found in the External database 

3. To add a  new column to the event search results  table do the following:  

3.1. Click Add (Fig. 4.3—43, 3). As the result Fields configuration dialog box opens (Fig. 4.3—

44). 
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Fig. 4.3—44 Adding a new column to the event search results table 

3.2. In the «Field name in the DB» enter the column’s name in the connected recognizer’s 

database, which content is required to be displayed in the event search results table ( 

Fig. 4.3—44, 1).  

3.3. In the «Field name in the interface» enter the name of this column in the event search 

results table (Fig. 4.3—44, 2). 

3.4. Click «Save» to save the applied changes and close «Fields configuration» dialog 

window (Fig. 4.3—44, 3). 

Note. Click «Cancel» to close this window without saving any changes (Fig. 4.3—44, 4). 
4. To edit column’s name in the event search results table do the following: 

4.1. In the group «Available fields» select the column, the name of which has to be changed 

(Fig. 4.3—43, 1). 

4.2. Click «Edit» (Fig. 4.3—43, 4). 

4.3. As a result «Configure fields» dialog box with blocked «Field name in the interface» 

field is displayed (Fig. 4.3—45). 

 
Fig. 4.3—45 Editing the column’s name in the event search results table 

4.4. Change the columns name in a required way in the event search results table and save 

the changes (see steps 4.3-4.4). 

5. Click «OK» to save the changes and close the «Displayed fields selection» dialog window (Fig. 

4.3—43, 5). 
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Note. Click «Cancel» to close this window without saving any changes (Fig. 4.3—43, 6). 

Setting up the event search results is completed.  
 

4.3.12.1.3 Set up the video archive  

Video recordings of events are displayed in video archive. To set up the video recordings 

playback do the following: 
1. Select «Settings» in the main menu of the Event search in Recognizers DBs (Fig. 4.3—46) 

 

Fig. 4.3—46 Access to search results setup  

 
As a result «Settings» dialog box is displayed (Fig. 4.3—47). 

 

Fig. 4.3—47 Settings dialog box  

 

2. Go to «Configure video archive » tab (Fig. 4.3—48, 1) 
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Fig. 4.3—48 Video archive setting 

3. Select Overlay mode in the Overlay dropdown list.( see Table 4.3-3, Fig. 4.3—48, 2) 

Note. Overlay is used to process the video using the video card and Direct X libraries, before it is 

displayed. Overlay allows to improve the image due to optimization of the pixel color settings. At the 

same time, the CPU’s load reduces as the video is processed with the resources from the video capture 

card.  

Table 4.3-3 Overlay mode 

Overlay mode Description 

«No» Videos from video cameras are not processed by video card  

«Overlay 1» Videos from video cameras are processed as one stream  

«Overlay 2» (set on default) Videos from video cameras are processed independently of 

one another  

 

4. In «Compression» field set the cursor in position that determines video compression degree 

(see Fig. 4.3—48, 3).  Minimal compression value is «None» – maximal video size, best quality. 

Maximal compression value is «Maximum» – minimal video size, worst quality.  

5. To save changes click «ОК» (see Fig. 4.3—48, 4).   

The setting of the events video recordings playback is completed.  

 

4.3.12.2 Forming the search query 

There is a possibility to form a search query: 
1. By events; 

2. By alarms. 
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4.3.12.2.1 Forming the search query by events 

Forming the search query by events is done in the following way: 
1. Go to the tab Search by events (Fig. 4.3—49). 

 
Fig. 4.3—49 Search by events tab 

2. From the list Search operation (Fig. 4.3—49, 1) select a logical construction, used for uniting 

several elements of the key phrase, corresponding to numbers of the vehicle, that are being 

searched: 

2.1. «and» – for searching by numbers, containing all the elements of the key phrase; 

2.2. «or» – for searching by numbers, containing  at least one element of the key phrase. 

Note. For example, search query ‘[а-м]3_2 and 02’ may return events with numbers ‘а302мм63’, 

‘а312мм02’. 

 
3. In the field Vehicle’s numbers (Fig. 4.3—49, 2) enter the key phrase, consisting of one or several 

comma separated elements, corresponding to the plates ‘numbers that are being searched. 

Note. The key phrase may include usual characters and picture-characters in the required 

combination (Table 4.3-4). 
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Table 4.3-4 Picture-characters 

Picture-characters Description of Picture-

characters  

Example of search query 

% Any string in length  from zero 

and more characters 

Search query ‘а%385%78’ returns numbers, containing the elements 

‘а’, ‘385’ and ‘78’, divided by any number of characters, for 

example ‘АО38578’, ‘а385мк78’ 

_ (underlining) Any single character Search query ‘2__5’ returns numbers, containing the  sequence of 

four characters , the first of which is ‘2’, the last one is ‘5’,for 

example, ‘А256577’, ‘2115ОК43’ 

[] Any single character , that is 

contained in the range ([а-е]) or 

in the set ([абвгде]) 

Search query ‘[е-м][2-5]53’ returns numbers, containing the  

sequence of four characters. The  sequence  ends in ‘53’, the first 

character belongs to the range е-м, the second one belongs to the 

range 2-5, for example, ‘к453мн02’, ‘м253вт63’ 

[^] Any single character , that is not 

contained in the range ([^а-е]) 

or in the set ([^абвгде]) 

Search query ‘[^е-м] 499’ returns numbers, containing the sequence 

of four characters. The  sequence  ends in ‘499’, the first character 

does not belong to the range е-м, for example ‘в499вк57’, 

‘н499578’ 

 

4. Set the checkbox Number not recognized if it is necessary to display all the numbers (Fig. 4.3—

49, 3). 

Note. Selection on one checkbox Number not recognized is active only with logical construction 

selection «OR» in the dropdown list Search operation. 

5. Set the checkbox Recognized partially if it is necessary to display partially recognized numbers 

(Fig. 4.3—49, 4). 

6. In the group «Plate region» set the checkboxes for those regions, which events should be 

returned while being searched (Fig. 4.3—49, 5).  

7. In the group «Date/time» (Fig. 4.3—49, 4, 5) set the time boundaries within which the required 

events have been registered. On default these boundaries are not activated (checkboxes from 

and to are disabled). To activate the boundaries it is necessary to set the checkboxes From 

and/or To and then click « »button (Fig. 4.3—49, 6-7) and in the appeared calendar set the 

required date. Enter the required time in the field From and/or To. In case, if only upper or 

bottom boundary is selected, the search query will return the events, having been registered 

before or after the set deadline correspondingly. To disable the search by data and time one 

should uncheck From and To checkboxes.  

8. In the License plate recognizers (Fig. 4.3—49, 8) set the checkboxes for those plate recognizers, 

which events are to be returned while being searched. 

Note. On default, information about objects removed from the Intellect software package is not 
displayed in the «Plate recognizers» group. Select  «Show deleted» in the «View» menu of the «Event 

search in the Recognizers DBs» main window to search by removed servers of plate recognizers (Fig. 

4.3—50). 
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Fig. 4.3—50 Configure the displaying of removed objects 

After this all removed servers of plate recognizers will be displayed in the «Plate recognizers» group 

(Fig. 4.3—50). Set checkboxes for those plate recognizers which will be used while being searched. 

9. From the list Registered speed (Fig. 4.3—49, 9) select the required filter of vehicle’s speed and 

then in the activated field (fields) (Fig. 4.3—49, 10) enter the threshold value(values) of vehicle’s 

speed.  

The following speed filters are available: 

9.1. «No matter» – events of the vehicle, moving with any speed will be returned. 

9.2. «More» – events of the vehicle, moving with a speed, exceeding a single threshold 

value, will be returned. 

9.3. «Less» – events of the vehicle, moving with a speed, not exceeding a single threshold 

value, will be returned. 

9.4.  «Interval» – events of the vehicle, moving with a speed, belonging to a single entered 

threshold value, will be returned. 

10. From the Direction list (Fig. 4.3—49, 11) select the required filter concerning the direction of the 

vehicle.  The following direction filters are available: 

10.1. «No matter» – events of the vehicle, moving in any direction concerning the LP 

recognizer’s camera will be returned. 
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10.2. «From the camera» – events of the vehicle, moving from the LP recognizer’s 

camera will be returned. 

10.3.  «To the camera» – events of the vehicle, moving to the LP recognizer’s camera 

will be returned. 

11. In the Countries group (Fig. 4.3—49, 12) set the checkbox for the country, which events should 

be returned while being searched. 

12. From the list Search operation (Fig. 4.3—49, 13) select a logical construction, used for uniting 

several elements of the key phrase, corresponding to numbers of the vehicle, that are being 

searched: 

12.1. «and» – for searching by numbers, containing all the elements of the key 

phrase; 

12.2. «or» – for searching by numbers, containing at least one element of the key 

phrase. 

13. In the Comment field (Fig. 4.3—49, 14) enter the key phrase, containing one or several comma 

separated elements, corresponding to the comments, that are being searched. 

14. Set the Blank comment checkbox in case if the event that is being searched can be left 

uncommented (Fig. 4.3—49,15). 

Note. The selection of this Blank comment checkbox is active only with logical construction 

selection «OR» in the dropdown list Search operation. 

15. From the Validity list (Fig. 4.3—49, 9) select the required Validity filter and then in the activated 

field (fields) (Fig. 4.3—49, 10) and enter the threshold Validity value (values). The following 

Validity filters are  available: 

15.1. «No matter» – events of the vehicle, which numbers have been recognized with 

any validity. 

15.2. «More» – events of the vehicle, which numbers have been recognized with 

validity, exceeding the entered threshold value. 

15.3. «Less» – events of the vehicle, which numbers have been recognized with 

validity, not exceeding the entered threshold value. 

15.4.  «Interval» – events of the vehicle, which numbers have been recognized with 

validity, belonging to the entered threshold value. 

Forming the search query by events is completed. 

After forming the search query one should run its processing (see section «Query launching »). 

4.3.12.2.2 Forming the search query by alarms 

Forming the search query by alarms is done in the following way: 
1. Go to the tab Search by alarms (Fig. 4.3—51). 
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Fig. 4.3—51 Search by alarms tab 
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2. Repeat steps 2-14 of the section «Forming the search query by events» as applied to interface 

elements of the tab Search by alarms (Fig. 4.3—51, 1). 

3. In the group External database (Fig. 4.3—51, 2) set the checkboxes for those external databases, 

which events have to be returned in search query results.  

Note 1. This setting is relevant in case, when the checkbox the number is found in the database is 

set in the group Alarm type (see step10). 

      Note 2. The External database group contains a list of all the databases that have  ever 

been used together with LPR channel module but, on default, databases removed from the 

Intellect software package are not displayed in the list. Select the «Show deleted» in the 

«View» menu of «Event search in the Recognizers DBs» main window to search by removed 

servers of plate recognizers (Fig. 4.3—52). 

 
Fig. 4.3—52 Configure the displaying of removed objects 

As a result, all external databases removed from the system will be displayed in the list. Set 
checkboxes for those databases which will be used while being searched. 

 
4. From the list Permitted speed (Fig. 4.3—51, 3) select the required speed filter, permitted on the 

controlled road area and then in the activated field (fields) (Fig. 4.3—51, 4) enter the threshold 

speed value (values) in km/h. 

The following filters of the permitted speed are available: 

4.1. «No matter» – events of the vehicle, registered on the road area with any permitted 

speed will be returned. 

4.2.  «More » – events of the vehicle, registered on the road area with any permitted speed, 

exceeding the entered threshold value will be returned. 

4.3.  «Less» – events of the vehicle, registered on the road area with any permitted speed, 

not exceeding the entered threshold value will be returned. 

4.4.  «Interval» – events of the vehicle, registered on the road area with any permitted 

speed, that belong to the entered threshold value range will be returned. 

5. Form the list Speeding (Fig. 4.3—51, 5) select the required speeding filter and then in the 

activated field (fields) (Fig. 4.3—51, 6) enter the threshold value (values) of speeding in km/h. 

Note 1. This setting is relevant in case, when the checkbox Speeding is set in the group Alarm 

type» (see step 9). 

Note 2. The value of speeding is calculated as a difference between the fixed vehicle’s speed and 

the speed, permitted on the controlled area of the road. 

 
The following filters of the speeding are available: 

5.1.  «No matter» – events of the vehicle, moving with any overspeeding or with the absence 

of it will be returned. 

5.2.   «More » – events of the vehicle, moving with overspeeding, exceeding the entered 

threshold value will be returned. 

5.3.  «Less» – events of the vehicle, moving with overspeeding, less than the entered 

threshold value will be returned. 



 51 

5.4.  «Interval» – events of the vehicle, moving with overspeeding, in the entered range of 

threshold values. 

6. From the list«Alarm handling delay, sec» (Fig. 4.3—51, 7) select the required filter according to 

the alarm handling delay and then in the activated field (fields), (Fig. 4.3—51, 8) enter the 

threshold value (values) of delay time in seconds. 

The following filters of alarm handling delay are available: 

6.1. «No matter» – alarms, accepted in any time after being registered or unaccepted at all. 

6.2. «More» – alarms will be returned, accepted with a delay, exceeding the entered 

threshold value. 

6.3. «Less» – alarms will be returned, accepted with a delay, not exceeding the entered 

threshold value. 

6.4.  «Interval» – alarms will be returned, accepted with a delay, belonging to the entered 

threshold value. 

Note. This setting is relevant in case if from the list Alarm processed the value No matter or 

Processed is selected (see step 10). 
7. In the group Alarm type  (Fig. 4.3—51, 9) set the checkboxes for those alarms, which have to be 

returned in results of search query: 

7.1. «No matter» — alarms will be returned with any alarm type or with the absence of it. 

7.2. «Overspeeding» — events will be returned for which overspeeding has been registered. 

7.3. «LP found in database» — events will be returned which plates have been found in the 

external database. 

7.4. «Alarm set by operator» — alarms will be returned, triggered manually. 

8. From the list «Alarm processed» (Fig. 4.3—51, 10) select the required filter according to the 

alarm processing factor: 

8.1. «No matter» —both processed and unprocessed   events will be returned. 

8.2. «Alarm is not processed» — only unprocessed   events will be returned. 

8.3. «Alarm processed» — only processed   events will be returned. 

Forming the search query by alarms is completed. 

After forming the search query one should launch its processing (see section «Query 

launching»). 

4.3.12.3 Query launching 

After forming the search query by vehicles or by alarms one should launch its processing, 

clicking «Find» (Fig. 4.3—53, 1). 
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Fig. 4.3—53 Query launching 

As a result search results table will open (Fig. 4.3—53, 2). 

Note. To clear the tabs Search by events, Search by alarms from the entered search criterion it is 

convenient to use Reset button (Fig. 4.3—53, 3). 

4.3.12.4 Viewing and printing the search results 

Columns of Search results table (Fig. 4.3—54, 1) are displayed in accordance to the settings, 

given in the dialog window «Selection of displayed fields» (see section «Events search results 

setup»).  

Description of the column’s content is given in the same section of the Guide (Table 4.3-1). 
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Fig. 4.3—54 Events search results 

For result’s navigation in the table there are used the following interface elements (Fig. 4.3—

54): 

1. button « » – transfer to the first page of the table; 

2. button « » – transfer to the previous page of the table; 

3. field « » – transfer to the required page of the table; 

4. field « » - number of pages in the table; 

5. button « » – transfer to the next page of the table; 

6. button « » – transfer to the last page of the table. 

Note. To transfer to the required page one should enter its number in the field 2 (Fig. 4.3—54, 

2), and then click «Enter». 
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To print the Event search results or/and export them to one of the most commonly used formats 

select the point «File» of the main menu in the window «Event search in the Recognizers DBs » 

(Fig. 4.3—55). 

 
Fig. 4.3—55 Printing and/or exporting the Events search results 

As a result preview report program will launch. In the window of this program there will be 

displayed License plates protocol (Fig. 4.3—56). 
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Fig. 4.3—56Event search results report 

Perform the necessary operations (Table 4.3-1) with a report and then quit the program Preview 

report by following the points of the main menu File ->Exit or by clicking the button « » (see 

step 4 in the section « Printing and/or exporting the Vehicle’s data»). 

4.3.12.5 Previewing and printing the data about the event 

To view the data about the event it is necessary to make a left click upon the corresponding 

string in the search results table. View event dialog window will open in result (Fig. 4.3—57). 
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Fig. 4.3—57 View event 

In the View event there are displayed the following event characteristics: 
1. Video frame with a sign, containing the following data (Fig. 4.3—57, 1): 

1.1. Date and time of receiving the data about the vehicle; 

1.2. Vehicle’s speed; 

1.3. Vehicle’s direction; 

1.4. Speed, permitted on the controlled road area; 

1.5. ID of speed’s detector; 

1.6. Control site; 

2. Vehicle’s identified plate (Fig. 4.3—57, 2); 

3. Vehicle’s plate detector (Fig. 4.3—57, 2) 

4. Date and time  of identifying the vehicle’s plate (Fig. 4.3—57, 2); 

5.  Vehicle’s  speed(Fig. 4.3—57, 2); 

6. Vehicle’s direction according to the LP recognition camera (Fig. 4.3—57, 2); 

7. Alarm’s reason (Fig. 4.3—57, 2); 

8. Data  about the vehicle for the external  LP database in case if the identified number has been 

found there (Fig. 4.3—57, 3); 

9. Comments to the event (Fig. 4.3—57, 4). 

To print the Report or/and export it to one of the most commonly used formats click the «Print» button 
(Fig. 4.3—57, 5). Preview report program will launch in result. In the window of this program there will 
be displayed Vehicle characteristics report. (Fig. 4.3—58). 
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Fig. 4.3—58 Vehicle’s data report 

Perform the necessary operations (Table 4.3-1) with a report and then quit the program Preview report 
by following the points of the main menu File ->Exit or by clicking the button « » (see step 4 in the 
section « Printing and/or exporting the Vehicle’s data»). 

4.3.12.6 Forming the Active tracking database 

The Active tracking database is the PC Auto-Intellect database and is filled up by operator via LPR 
channel.  
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Note. It is impossible to remove and change records excepting the status of stolen vehicle reports 

changing via LPR channel. 

The following conditions should be met for total interaction of the Active tracking database and 

LPR channel: 
1. The Active tracking database is connected to the PC Auto-Intellect as an external plates 

database. 

2. This external database is used by LPR Channel for analyzing the identified plates.  

Meeting the following conditions the interaction of the Active tracking database and LPR 

channel is done in the following way: 
1. Vehicle’s plate is entered by operator to the Active tracking database via LPR channel, stating 

the reason. 

2. LPR channel compares the plate of a passing vehicle with plates, stored at the Active tracking 

database. In case, if the correspondence of the identified plate and the plate, stored at the 

Active tracking database is set up, alarm is generated. 

Active tracking option is convenient to be used in the Auto-Intellect distributed system, as it enables the 
operator at his workstation to notify the remote workstation operators about the vehicle that is to be 
captured. 
Editing the data about the vehicle in the Active tracking database is done in the following way: 

1. Click the «External Plates Database» (Fig. 4.3—59) in the main menu of the Event search in the 

Recognizers DBs window. 

 
Fig. 4.3—59 Access to the External Plates Database  

2. As a result Internal SVDBs dialog window will open (Fig. 4.3—60). 

 
 

Fig. 4.3—60 Internal SVDBs window 
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3. Click «Enter» to add records to the database (Fig. 4.3—60). 

4. Enter the vehicle plate in the « License plate number:» field (Fig. 4.3—61, 1). 

 
Fig. 4.3—61 Add the new orientation to external database 

5. If the fact of vehicle driving to the stolen vehicle report by all boundaries is to be checked, do 

the following: 

5.1 Set the «Check the fact of driving» checkbox (Fig. 4.3—61, 2). 

5.2 Enter the time period using the «up-down» buttons and select the measuring unit from the 

drop-down list (Fig. 4.3—61, 3). 

6. Enter the description of reason by which the stolen vehicle report is created in the «Additional 

information» field (Fig. 4.3—61, 4). 

7. Click «Save» to save changes (Fig. 4.3—61, 5). 

Note 1. Click «Cancel» to cancel changes (Fig. 4.3—61, 6). 

Note 2. Entered stolen vehicle reports are added to the database with the «Active» status. 

8. Go to the «All Stolen Vehicle reports» tab to change the status of stolen vehicle report (Fig. 

4.3—62). 
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Fig. 4.3—62 View the stolen vehicle report in external database 

9. The list of stolen vehicle reports in database is displayed in the table (Error! Reference source 

ot found., 1): 

9.1 Plates of vehicles are wanted are specified in the «License plate» column. 

9.2 Time of adding the stolen vehicle report to the database is specified in the «Date and 

Time» column. 

9.3 Operator who has added the stolen vehicle report to the database is specified in the 

«Operator» column. 

9.4 The reason by which the stolen vehicle report is created is specified in the «Comment» 

column. 

9.5 Checkboxes are set on the active stolen vehicle reports while viewing in the «Active» 

column. 

10. Enter the part of the sought-for vehicle in the «License plate:» field and click «Search»  to search 

vehicle in the table (Fig. 4.3—62, 2). Records corresponding to the request parameters will be 

highlighted red in the table. 

11. Set checkboxes opposite those stolen vehicle reports which are active and uncheck checkboxes 

opposite those reports which are inactive in the «Active» column to change the reports status 

(Fig. 4.3—62, 4). 

12. Click «Refresh» to refresh the list of stolen vehicle reports (Fig. 4.3—62, 5). 

13. Click «Save» to save changes (Fig. 4.3—62, 6). 

Adding the vehicle data to the External Plates Database is completed. 
 

4.3.12.7 Viewing the video archive by event 

Viewing video archive by event is started in three ways: 
1. Call for a required event contextual menu by clicking right mouse button and select «Video 

archive» option (Fig. 4.3—63).  
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Fig. 4.3—63 Contextual menu of event  

2. Select the required event by single clicking left mouse button and click «Ctrl» + «M» key 

combination.  

3. Holding «Shift» key click the required event twice with left mouse button. 

Video archive with videos of this event opens after carrying out any of above mentioned operations (Fig. 

4.3—64). 

 
Fig. 4.3—64 Viewing the video archive by event 

To close the video archive it is necessary to click the « » sign in the right upper corner of the window 

(Fig. 4.3—64). 
 
Viewing the video archive by event is completed.  
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5 Description of the Auto-Intellect user interface 

5.1 The Traffic Monitor interface object 

5.1.1 Current value tab, Table sub-tab 

Figures 5.2.1-1 and 5.2.1-2 show the Table sub-tab of the Current value tab displayed by lane 

and by direction respectively (depending on the system setup).  

 

 
 

Figure 5.2.1-1 The Table sub-tab of the Current value tab displayed by lane 
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Figure 5.2.1-2 The Table sub-tab of the Current value tab displayed by direction 

 

Table 5.2.1-1 describes the elements of the Table sub-tab. 

 
Table 5.2.1-1 The elements of the Table sub-tab of the Current value tab 

 

Field name Description 

Time of registration The time when the last vehicle passed 

Total number of vehicles Total number of registered vehicles of all types 

Motorcycles The number of registered motorcycles 

Passenger cars The number of registered passenger cars 

Trucks less than 12 m long The number of registered trucks less than 12 m long 

Trucks more than 12 m long The number of registered trucks more than 12 m long 

Buses The number of registered buses 

Registered speed of the 

vehicle 

The speed of the last registered vehicle, km/h 

Vehicle length Total length of the registered vehicle, m 

Average speed for all vehicles Average speed for all registered vehicles, km/h 

Average speed for passenger 

cars 

Average speed for passenger car vehicles, km/h 

Average speed for trucks Average speed for registered trucks, km/h 

Distance between vehicles The distance between the last vehicle and the previous one, m  

Road load Average road load, % 

Number of speed overruns The number of speeding violations 

Moving along the oncoming 

lane 

The number of moving along the oncoming lane events 

Number of vehicle stops The number of vehicles stopped in the lane 



 64 

Field name Description 

Jam Traffic jam indicator 

Number of incidents Total number of road rules violations for the lane (direction) 

 

5.1.2 The Charts sub-tab of the Current value tab 

Figures 5.2.2-1 and 5.2.2-2 show the Charts sub-tab of the Current value tab displayed by lane 

and by direction, respectively (depending on the system setup).  

 

 
Figure 5.2.2-1 The Charts sub-tab of the Current value tab displayed by lane 
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Figure 5.2.2-2 The Charts sub-tab of the Current value tab displayed by direction 

 

Table 5.2.2-1 describes the elements of the Charts sub-tab. 

 
Table 5.2.2-1 The elements of the Charts sub-tab of the Current value tab 

 

Element Description 

 
The Traffic Detector name 

 

The lane number or direction 

 Total number of vehicles 

registered for the lane 

(direction) 

 
Indication of a traffic jam in the 

lane (direction) 

 

Chart showing the number of 

vehicles in the lane (direction) 
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Element Description 

 

Chart showing the road load of 

the lane (direction), % 

 

Chart showing the statistics for 

the average speed of different 

vehicles types 

 

5.1.3 Statistics tab, Table sub-tab 

Figure 5.2.3-1 shows the Table sub-tab of the Statistics tab. 

 

 
Figure 5.2.3-1 The Table sub-tab of the Statistics tab 

 

Table 5.2.3-1 describes the elements of the Table sub-tab. 

 
Table 5.2.3-1 The elements of the Table sub-tab of the Statistics tab 

 

Element Description 

 
Set of elements for entering 

the beginning and end dates 



 67 

Element Description 

and times of the traffic 

statistics period 

 The Refresh button refreshes 

the displayed statistics. 

 

 
The Save as button exports the 

displayed statistics to a file 

 
Set of elements for selecting 

the statistic frequency 

 

Traffic statistics results 

5.1.4 Statistics tab, Charts sub-tab 

Figure 5.2.4-1 shows the Charts sub-tab of the Statistics tab. 

 

 
Figure 5.2.4-1 The Charts sub-tab of the Statistics tab 
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Table 5.2.4-1 describes the elements of the Charts sub-tab. 

 
Table 5.2.4-1 The elements of the Charts sub-tab of the Statistics tab 

 

Element Description 

 
Set of elements for entering the 

beginning and end dates and 

times of the traffic statistics 

period 

 The Refresh button refreshes the 

displayed statistics. 

 

 
The Save as button exports the 

displayed statistics to a file 

 
Set of elements for selecting the 

statistic frequency 

 The Traffic Detector name 

 

The lane number 

 

Incident statistics for the lane 

 

The road load chart 
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Element Description 

 

Chart showing the number of 

vehicles in the lane  

 

5.2 The LPR channel interface description 

5.2.1 The Events monitor 

The events monitor contains the following interface elements (Fig. 5.2—1,Table 5.2-1). 

 
Fig. 5.2—1 The Events monitor 

  
Table 5.2-1 The Events monitor interface description 

№  Element Description 

1 

 

Detector of passing vehicle’s plate  
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№  Element Description 

2 

 

Signed frame with a passing vehicle 

3  

 

Identified vehicle’s plate and speed (when the Uragan or 

CARMEN-Auto modules are used, the Radar module should be 

connected) 

 

5.2.2 The On-line monitor 

The On-line monitor contains the following interface elements (Fig. 5.2—2,Table 5.2-2). 

 
Fig. 5.2—2 The On-line monitor 

 

Table 5.2-2 The On-line monitor interface description 

№  Element Description 
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№  Element Description 

1 

 

Data about the last passed vehicle or event, selected in the identified 

vehicles protocol or in the alarms protocol 

 

2 

 

Transfer to the Events tab of the identified vehicles protocol. 

3 

 

  

Transfer to the alarms protocol tab. 

With alarms there displayed a video frame and number of the last alarm 

on the tab. 

4 

 

Hidden in the processes events protocols  

5 

 

Enabling/disabling setup filters. 

6 

 

Resuming the operative update of the displayed vehicle’s protocol. 

7 

 

Triggering the alarm by operator. 

8 

 

Alarm acceptance. 

9 

  

Transfer to the list  of bugs in LPR channel operation 

10 

 

Displaying the commentary to the selected event. 
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№  Element Description 

11 

 

The identified objects protocol or alarms protocol dependent on 

activated tabs- 2 or 3. 

12 

 

Roll down/roll up the displaying panel of comments and base. 

13 

 

Displaying the information from the external database. 

14 

 

Forming the report with data about the selected event. 

15 

 

Opening the search window in the plates recognizers databases. 

16 

 

Transfer to the video archive of identified vehicles. 

17 

 

Transfer to filter settings, used in protocols. 

18 

 

Comments to the selected event with stated data and time of the 

commentary.  

5.2.3 The Events search in recognizers databases 

The Events search in recognizers databases dialog window contains the following interface 

elements (Fig. 5.2—3,Table 5.2-3). 
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Fig. 5.2—3 The Events search in recognizers databases dialog window 

Table 5.2-3 The Events search in recognizers databases interface description 

№  Element                                    Description 

1 
 

The main menu, that enable to do the following 

operations: 

1. File command: 

1.1. Printing the events search results; 

1.2. Closing the window Events search 

in recognizers databases 

2. Settings command: 

2.1. Setting up the displaying of events 

search results; 

2.2. Connecting the recognizers 

databases. 

3. Database command: 

3.1. Selecting the databases for 

searching the events. 

4. Command Active tracking database 

4.1. Editing the  Active tracking user 

database 

2 

 

Selecting the type of search: by events or by alarms 
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№  Element                                    Description 

3 

 

Forming the search query of the selected type  

4 

 

Clearing the search form from the given search 

criteria 

5 

 

Launching the search query processing 

6 

 

Events search results table 

7  Navigation panel of the events search results  

5.2.4 The preview report 

The preview report  program window contains the following interface elements (Fig. 5.2—

4,Table 5.2-4). 
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Fig. 5.2—4 The preview report 

Table 5.2-4 The preview report interface description 

№ Element Description 

1 
 

Main program’s menu for viewing 

the reports (operations with a file, 

operations of previewing and 

navigating the report, operation with 

a report, viewing the information 

about program) 

2 
 

Block of elements for operations 
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№ Element Description 

with a report file (printing, opening, 

saving, exporting the file) 

3 
 

Block of elements for operations 

with a report (displaying, content, 

search, update, edit) 

4 
 

Selecting the scaling mode and the 

scale of displaying the report 

5 

 
6 

 
Selecting the mode of displaying the 

report (displaying the pages by one 

page, nonstop page-by-page 

displaying) 

7 
 

Block of elements for navigation of 

the report 

8 
 

9 

 

Field for displaying the formed 

report 
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